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EXCEL Software Shortcuts & Tips 
 
April 2010 Newsletter: 
 

We don‟t all need or use the space allowed in an Excel spreadsheet. Most users probably 

stick with one sheet, up to 24 columns, and maybe a few hundred rows.  For the rest of 

you, here‟s a reminder on the maximums of Excel by version: 
 

 

Maximum 

Rows 

Max. 

Columns 

Max 

Sheets 

Excel 

2010 
1,048,576 16,384 255 

Excel 

2007 
1,048,576 16,384 255 

Excel 

2003 
65,536 256 255 

Excel 

2002 

(XP) 

65,536 256 255 

Excel 

2000 
65,536 256 255 

Excel 

97 
65,536 256 255 

Excel 

95 
16,384 256 ? 

Excel 5 16,384 256 ? 
 

If you have extremely large spreadsheets – read up on the 64 bit version of Excel 2010 – 

it claims to make working with large files quicker due to use of more memory.  

 
 

Excel has some clever keyboard shortcuts to let you move to the extremes of your 

worksheet. „Extremes‟ doesn‟t mean the absolute end of the worksheet, rather the end of 

the current block of filled or unfilled cells. 
 

Hold Down: Active cell 

becomes: 

Ctrl + Right 

Arrow 

In cell with 

content 

Last cell in row 

with content 

Ctrl + Left Arrow 

In cell with 

content 

First cell in row 

with content 

Ctrl + Right 

Arrow 

First cell in row 

with content 
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In blank cell 

Ctrl + Left Arrow 

In blank cell  

Last cell in row 

with content 

Ctrl + Up Arrow First cell in 

column with 

content 

Ctrl + Down 

Arrow 

Last cell in 

column with 

content 

Ctrl + End Last cell in 

worksheet with 

content. 

Ctrl + Home First non-frozen 

cell, typically A1 

 
January 2010 Newsletter: 
If you are using subtotals in Excel (from the DATA menu), you might need to combine 

that with using the Advanced Filter option (also DATA menu) to copy just your subtotals 

to another worksheet or workbook. 

 
September 2009 Newsletter: 
Have a workbook full of formulas? There is an option in Excel to show formulas in their 

cells.  The keyboard shortcut for this is: 

CTRL + ` 

where the second key is the grave – to the left of the 1 key at the top of your keyboard.  

This shortcut works as a toggle so if you should accidentally hit these keys, hit them 

again. 

The longer way is: 

2003 – Tools/Options/View/Formulas 

2007 – Excel Options/Advanced/Display options for this worksheet/Show formulas in 

cells instead of their calculated results 

 

 

Upper/Lower case in Excel can be a tricky thing to obtain.  There are three functions in 

Excel that will help with this situation.  Take note that you must keep the original text 

where it is and enter these functions into another cell to avoid a circular reference error 

from Excel. 

PROPER – puts the text in proper case 

LOWER – puts the text in all lowercase 

UPPER – puts the text in all uppercase 

Each function takes just one argument – the cell reference.  
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January 2009 Newsletter: 
When you‟ve got reams of data organized by one column it may be hard to see the „big 

picture‟.  Excel‟s built-in subtotal feature might help.  Click Subtotal on the Data ribbon 

in Excel 2007 or choose Subtotals from the Data menu in previous versions.  By default it 

offers a sum-type subtotal at each change in the leftmost column, but you can pick the 

column and operation you prefer. You can even create multiple subtotals, if needed. 

 

Checking Print Preview to see if your last column or row is orphaned on its own page is 

fine, but Page Break Preview may be even faster.  Click Page Break Preview on the View 

ribbon in version 2007 or choose Page Break View from the View menu in previous 

versions.  Blue lines will appear showing the edges of pages and these can be dragged to 

where you‟d prefer they be located. 

 

The Drawing Toolbar 
The drawing toolbar is mostly used in PowerPoint, but is also available in Word and 

Excel.  It defaults to showing at the bottom of your screen.  If it is not visible, open the 

View menu and choose Toolbars, then choose Drawing.  This toolbar is handy because it 

has shortcuts for creating all types of shapes, lines, word art, diagrams, and other graphics 

within your presentation, document, or spreadsheet. At the right of the toolbar are icons 

to adjust the thickness or type of a line or arrow as well as boxes that lead to menus of 

shadow and 3D options for your various graphics.  Experiment with this and let your 

creativity show! 

 
Internet Extras: 
Conditional formatting – a choice on the Format menu – applies your selected 

formatting (bold, colors, etc.) only when a specified condition is true.  For example – if 

the value of the cell is over $500, display the total in blue. 

 

When you create a line chart in Excel, missing data points (blank cells) will create gaps 

in your line.  There are three options in Excel for how to handle this – not plotted 

(leave gaps); treat as zero, or interpolate the data (connect the line between the existing 

data points).  Select your chart and choose Tools / Options.  Click the Chart tab and set 

your default to your personal preference.  You can change the preference for each chart 

but you‟re choice always applies to the entire chart. 

 

Some handy functions: 

COUNTIF – counts the number of times a condition is met 

SUMIF – sums the values when a condition is met 

MOD – returns the remainder when one number is divided by another 

DATEDIF – returns the time between two dates, measured in your choice of 

completed years, completed months, or days  (handy for calculating age) 

NETWORKDAYS – calculates the number of workdays (excludes weekends) 

between two dates 

CONVERT – converts measurements from one unit to another, as you specify 
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October 2008 Newsletter: 

The zoom box, or magnifying option, is a great help in Excel.  If you need to only 

magnify a specific few cells, use a click and drag to select the cells and then use the 

drop down list on the toolbar next to the zoom box and choose Selection.  Excel will 

magnify your selection up to 400% to fill the viewable are of the file‟s window.  To 

restore, use the zoom dropdown to reset it to 100%.   

 

If you‟ve hidden columns in your spreadsheet and can‟t make them appear again, try 

this:  Press F5 (GoTo) type in A1 and press Enter.  Now hold down the Shift key and 

press the right arrow.  This highlights everything from A1 to the first visible cell in 

row 1.  Finally, select Format / Column / Unhide and your data should reappear!  To 

do the same for hidden rows, press the down arrow and select Format / Row instead. 

 
 
June 2008 Newsletter: 
We all make mistakes and early on in school we learned how to „erase‟ our mistakes.  

Here are several ways to „erase‟ mistakes in Word where the function is called UNDO. 

 Edit/Undo (erases the last action) 

 The Undo icon on the standard toolbar. (Arrow curved and pointing left) 

 The drop down arrow next to the Undo icon on the standard toolbar – allows 

„erasing‟ of up to 99 actions. 

 CTRL + Z 

 
 
February 2008 Newsletter: 
 Easily center your worksheet on the printed page: 

1. Click on File 

2. Choose Page Setup 

3. Click on the Margins tab 

4. Check the box(es) at the bottom in the Center on Page section . 

Remember:  centering is based on the margins of the page and not the dimensions of 

the paper. 

 

 If you‟re entering fractions and watching them become dates, it‟s time to format 

your cell : 

1. Click on Format 

2. Choose Cells 

3. Click the Number tab 

4. Select Fraction and choose an appropriate type. 

5. Click OK 

 

 Document your named ranges.  If you‟ve named several ranges of data within your 

spreadsheet, they may be difficult to keep track of.  Go to an unused section of your 

worksheet and you can create a list of those names: 

1. Choose Insert / Name / Paste 

2. When the Paste Name box appears, click the Paste List button. 
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September 2007 Newsletter: 

Avoid broken lines in line charts—if data is missing or a cell is blank, a line 
chart will have a gap. To avoid the gaps, enter the following into the cell: 
=NA() - this indicates to Excel that the value is Not Available and it will draw a 
continuous line between the two cells on either side of the gap. 
 
Display the results of data arithmetic in hours—when adding or subtracting two 
date and time entries, Excel displays the result as a fraction of a day, multiply 
by 24 to see your results in hours. 

 
 
May 2006 Newsletter: 
 
It‟s one thing to lock a formula to prevent changes.  It‟s quite another to hide the formula 

all together, but it can be done!  Select the cell with the formula and then choose Format / 

Cells and switch to the Protection tab.  Select the Hidden check box and click OK.  Now 

you must activate worksheet protection – Tools / Protection / Protect Sheet.  Change as 

needed and click OK.  Your formula bar should now remain empty when the cell is 

selected. 

 

You can change many things about Excel – including the fact that a double click opens 

the cell for editing.  Choose Tools / Options and click the Edit tab, deselect the check box 

labeled “edit directly in cell” and click OK. 

 
February 2006 Newsletter: 
If you‟ve entered a hyperlink into a cell and now need to edit it rather than activate it, 

hold the mouse button down a little longer than usual so that the pointer changes from the 

hand to the traditional pointer. 

 
Internet Extras: 
If you need to view different parts of a worksheet at the same time, you can split 
the view of your worksheet into scrollable panes.  To create a horizontal split, 
drag the split box (the small rectangle directly above the vertical scroll bar) to the 
position on the worksheet where you want the split made.  To create a vertical 
split, drag the split box that’s to the right of the horizontal scroll bar to the desired 
position.  To remove a split, simple double-click on the split line. 
 
October 2005 Newsletter: 
 
To quickly double underline the contents of a cell, simply press the [Shift] key and hold it 

down then click the Underline button on the toolbar 

 

In version 2002, you can add color by changing the background color of a sheet tab.  

Right-click the sheet tab and choose Tab Color then pick from the palette and click OK 
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Internet Extras: 
 
Quickly create column or row headings with a sequence of dates: 
 Enter the first and second dates 
 Select both cells 
 With the black plus sign, click in the lower right corner of the selected cells 
and drag to fill the column or row headings.  Excel will duplicate the pattern of 
your first two dates as it fills in the remaining dates. 
 
Link your Excel spreadsheet to Outlook contacts.  Select the cell with the 
contact’s name (contact must already be entered in Outlook), press Ctrl+K to 
open the Insert Hyperlink box, in the Link to File or URL text box, type 
Outlook:Contacts/~(person’s name) and then click OK.  (Note:  do not include the 
parenthesis around the person’s name). 
 
Double underline something quickly in Excel by holding down the Shift key while 
clicking the Underline button on the formatting toolbar. 
 
Creating a data entry spreadsheet?  Use a drop down to limit the entry choices to 
a specific list!  Move off to an unused portion of the sheet and create the list of 
choices – all in one column.  Select the cell where you want the drop down list, 
choose Data / Validation.  Click on the Settings tab, in the Allow dropdown list, 
select LIST and in the Source text box, type the range that contains the list items.  
Click OK.  When the user clicks on that cell, the drop down arrow will appear. 
 
January & May 2005 Newsletters: 
 

In these newsletters we repeated tips from early newsletters. 
 
Sept 2004 Newsletter: 
 To rearrange columns in your worksheet:  Select the column(s) that need to 

move,  Move the mouse to the edge until it changes to a regular pointer arrow, press 

SHIFT and click and drag the column to the new location.  A faint “I” bar will 

indicate where the column will land when you release the mouse button.  Release 

the mouse and then the SHIFT key and your relocation is completed.  (Also works 

with rows in your worksheet.) 

 

 If you‟re using Find/Replace in Excel and get ahead of yourself by clicking 

the Find Next button one too many times, try this trick to “back up”:  hold the 

SHIFT key when you click Find Next and it becomes Find Last! 

 

 You can use the Form Toolbar to create dropdown, option, and check boxes 

for a data entry form.  From here you can also add buttons and scroll bars to your 

worksheet. 
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Internet Extras: 
Create a ‘smart form’ as part of your Excel spreadsheet.  You can create a form with 
spinners, check boxes, and combo boxes (drop downs) in Excel.  The first step is to open 
the FORM toolbar in order to see the icons that allow for simple addition of these controls 
to your spreadsheet.  Choose View / Toolbars / Forms to make the toolbar visible. 

 
April 2004 Newsletter: 
Scenario Manager is a tool included with Excel that makes it easy to automate your what-if 
models.  This allows you to store different sets of input values for variables and give each 
set a name.  For instance, if you’re working on a budget, you can save the base, one with a 
new office, and one with new staff, all in ONE Workbook! 
 

Named ranges make formulas much easier to read.  Highlight the range and then type a 
name in the name box. 
After you enter the first parenthesis for a function, press CTRL/Shift/A to have Excel 
display the function’s arguments. 
 

Missing data for your chart? If you have a zero value in your chart data you need to plan for 
how to display that.  Click on the chart, choose Tools / Options, click the chart tab, select 
the option you want for handling the missing data.  One option per chart. 

 
 
 
 
Internet Extra: 
 
Version 2002(XP) – If you‟re used to using the Merge & Center button for formatting 

headings, check out it‟s new functionality!  It now toggles, so you can also use the same 

button to Un-Merge cells 

 
January 2004 Newsletter: 
 
Charts add a lot, but why settle for the same old bars on your charts?  Select your data 

series by right clicking on one bar, then choose Insert / Picture / From File and locate a 

graphic file.  Your graphic will be substituted for the traditional bars in your chart for the 

selected data series. 

 

Scenario Manager makes automating your what-if tasks easier.  Store different sets of 

values for the same variables and give each set its own name!  This feature is accessible 

from the Tools menu. 

 

In version 2002 you can add color by changing the background color of a sheet tab.  

Right-click the sheet tab and choose Tab Color, pick from the palette, and Click OK 
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September 2003 Newsletter: 
 
Naming your cells can make reading and writing formulas much easier!  Select a cell or 

range, click on the name box at the left of the formula bar, type in your name and hit the 

Enter key.  Use the name you entered in your formulas. 

 

For version XP, but may work in older versions as well: 

 

When you enter a function, a ToolTip is automatically displayed below the active 

cell listing the arguments for the function you‟re working with.  Click the function 

name in the ToolTip to go right to HELP on that function.  To edit the value of an 

argument, click the argument in the ToolTip. 

 

 

If you need to put two text strings together in a single cell, it‟s call concatenating.  

Don‟t worry about learning a fancy function to do this.  Let‟s say you have first 

name in cell A1 and last name in cell B1 and want the full name in cell C1.  Click 

on cell C1 and enter =A1&B1.  The ampersand (&) indicates that you are putting 

text together rather than numbers that use the plus sign (+). 

 
February 2003 Newsletter: 
 
How about adjusting columns while in Print Preview?  Click on Margins and look for the 

small black handles at the top of the page.  These are the column borders and can be 

dragged to resize columns as needed.  

 
Internet Extras: 
 
To see how your spreadsheet will page when printed without using the print preview 

option, you can set up Excel to always display the page breaks.  Select Tools | Options | 

View Tab | select the page breaks box and click OK. 

 

To put a graphic in the background of your Excel spreadsheet, choose Format | Sheet | 

Background then locate your graphic file and double click to insert and close the dialog 

box. 

 

Conditional formatting can be a great time saver!  Let‟s say you need to have all the 

values in the total column that are greater than the quota in Green.  Select the column or 

row with the totals, choose Format | Conditional Formatting and enter your value test (in 

this case, greater than or equal to quota), then use the Format button to establish the 

formatting to be applied when your value test is true.  You can even add multiple value 

tests for the same data!  Click OK to get back to your spreadsheet and you should see all 

sales greater than quota in Green. 
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September 2002 Newsletter: 
 
To set print options for multiple sheets in the same workbook, group the sheets by using 

the CTRL or SHIFT key to click on multiple sheet tabs.  Open FILE – PAGE SETUP & 

set your print settings as needed and they will apply to all the grouped sheets. 

 

In most Office programs, if you have multiple files open and want to close them all 

quickly, hold down the SHIFT key while clicking on the FILE menu.  The Close option 

will now say CLOSE ALL. 

 

If you‟re inserting Hyperlinks (web sites or e-mail addresses) in your documents, 

spreadsheets or presentations and don‟t want them to show up in blue with the underline 

– remove the formatting!  Point at the hyperlink and click the right mouse button, from 

the pop-up menu, choose Remove Hyperlink and the formatting of blue underlined text 

will be removed. 

 
May 2002 Newsletter: 
 
To quickly double underline the contents of a cell simply press the [Shift] key and then 

click the Underline button on the toolbar. 

 
Internet Extras: 
  

CTRL+PageDown will move you to the next sheet within your workbook.   
 
CTRL+PageUp will move you to the previous sheet within your workbook. 
 
Quickly add sheets to an Excel workbook with Shift+F11 
 
To close all open workbooks, press SHIFT and open the File menu.  The usual 
Close option will be replaced with a Close All option. 
 
Right click on a hyperlink to get an option to edit the text or change the entire 
link.  This prevents your click from actually activating the hyperlink. 
 
If you’re protecting your worksheet so others cannot change your formulas, but 
would prefer that others not be able to even see the formula, before protecting 
your worksheet, activate the cell with the formula, then open the Format / Cells 
dialog box and choose the protection tab.  Click next to the Hidden tag. 
 
February 2002 Newsletter: 
 
To change existing data to thousands or millions—simply change the format.  
Choose Format / Cells then click on the Number tab and choose the Custom 

category.  In the Type box, enter #.##, for thousands or #.##,, for millions. 
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September 2001 Newsletter: 
  

Excel will treat numbers as text if they are preceded by a quotation mark (‘) when 
originally entered.  Excel will also treat fractions as fractions rather than dates if 
they are preceded by a question mark (?) when they are entered. 
 
To add a drop down list in your Excel spreadsheet, type your list entries in an 
unused area of your worksheet, Activate the cell to contain the drop down, 
choose Data / Validation, and select the Settings Tab.  In the Allow Drop Down 
list, select List.  In the Source box, select or enter the range of the list items in 
your sheet.  Be sure the In-cell Drop Down box is selected, then click OK. 
 
May 2001 Newsletter: 
  

To copy print options from one sheet to others within a workbook— activate the 
sheet to be copied, hold Shift or Ctrl and click on the tabs of the sheets to be 
copied to, then select File / Page Setup, click OK 
 
Use Ctrl+Page Up to activate the previous sheet in a workbook and Ctrl+Page 
Down to activate the next sheet in a workbook. 
 
February 2001 Newsletter: 
  

Create a series of totals by highlighting the range of cells to contain the totals 
and then using the AutoSum button 
 
To copy print settings from one sheet to another in the same workbook, activate 
the sheet to be copied.  Using either the Shift or CTL key, select the sheets to be 
copied to.  Select File / Page Setup and click OK. 
 
September 2000 Newsletter: 
 

To enter totals for all columns or rows in your spreadsheet, select the cells to 
contain totals and click AutoSum 
 
Charts, also known as graphs, can add quite a bit to any presentation and can be 
used in Word, Excel, or PowerPoint.  However, to get the best effect, you need to 
select the type of chart that will get your point across most effectively.  Here are 
some guidelines we received in one of our e-mail newsletters: 
 Pie Chart or Horizontal Bar – shows one thing at a time by emphasizing 

relationships. 
 Vertical Bar Chart – shows many things at one time, focusing on either the 

relative performance of each or highlighting one item. 
 Sliding Bar Charts – focus on more than one relationship 
 Fever chart or Line chart– shows trends 
 Clustered Vertical Bars – show many things at many times – be sure to 

use shading, texture or different rules to differentiate each item! 
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Internet Extras: 
Visible Page Breaks 
  Tools Menu / Options / View tab / Check off Page Breaks 
Double Underlines 
  To quickly double underline the contents of a cell, use the key  

combination SHIFT + the underline icon from the formatting toolbar 
Switching Sheets 
 Use CTRL+Page Up to move to the previous sheet or CTRL+Page Down  

to move to the next sheet within a workbook  
 
April 2000 Newsletter: 
 

Tools/Options/View contains a selection for Page Breaks.  Checking this tells 
Excel to always display page breaks, not just after you preview the worksheet 
 
October 1999 Newsletter: 
 
When working with multiple files, use the WINDOW/Arrange option to display all 
open files tiled to fit the screen, tiled horizontally or vertically, or cascaded. 


